MS Excel 2016 for the Mac

Reviewed 12/2016 by Kathy Handy for Saratoga Springs Public Library
SPREADSHEETS

A spreadsheet is simply an electronic worksheet or a table (like an accounting sheet) that lets you enter and work with figures and columns of information. Some word processing programs have mini-spreadsheet capabilities built into them in the form of TABLES, in which case you can use the word processor and insert a table of information that can process formulas and other mathematical operations. In Microsoft Word, you can use a table feature also, and there are ways to embed the table as a spreadsheet. For now, however, we’re going to work with the spreadsheet as a separate item using the program called, Microsoft Excel 2016, typically part of the Microsoft Office package.

You will notice that the spreadsheet in Microsoft Excel opens automatically with gridlines, and you can choose whether or not to view or print the gridlines. You will also notice that you are actually opening a new workbook that contains three electronic worksheets (the actual spreadsheets) labeled as such at the bottom of the screen. You can add new worksheets, rename them, and/or you can delete sheets as well, at any time.

To begin with, you will need to understand how to read the spreadsheet or worksheet. First of all, the cursor itself is different than it was in the word processor. In the word processor, you noticed the cursor as a vertical line or insertion point. On the spreadsheet, you will notice that the cursor or insertion point (the vertical line of which we spoke) is in the top portion of your screen known as the "formula bar." This area allows you to view the full contents of a cell and also allows you to correct mistakes or make changes to a cell entry. Your gray arrow keys or TAB button then allow you to move the rectangular cell marker (cursor bar) from one cell to another within the spreadsheet. Wherever this cursor bar is, that is where typewritten material will be sent. To move about on the spreadsheet, you will use the TAB button or the arrow keys while adjusting to viewing the cell contents in the editing area. You can also hit ENTER and then TAB or the arrow keys. Also, try shift and the TAB key to move backwards, one cell at a time.

Some Definitions:

Cell -- Where column and row intersect. Notice that the top of your spreadsheet has black letters identifying each column, beginning with A. The rows are numbered on the left hand side of the screen, beginning with 1. You will read your screen as you would a graph in order to tell the computer various things later on. Every cell has an address consisting of the column letter and row number.

For practice and to familiarize yourself with how to move in the spreadsheet, let's try a simple exercise. Move your cursor bar from the home position of A1 to cell location D6. Now return home to cell A1 by pressing fn + Command (or CTRL) + left arrow. Then move the cursor bar to cell location F15. Return home a different way, this time by tapping the up arrow key, then the left arrow key to return to cell A1. Now you know how to move about in the spreadsheet!! Again, try the TAB button as well, and SHIFT TAB to see what happens.

Formula -- Formulas tell the computer to perform some type of special computation or logical operation on a series of, usually numerical entries, but formulas can be performed on words or strings as well. Several pre-written formulas can be used and are programmed into the spreadsheet – these are called functions. We will use some of these functions in upcoming exercises, including:

=SUM adds a series of numbers
=MIN finds the lowest number in a series
=MAX finds the highest number in a series
=AVERAGE computes the average number of a series

There are other formulas/functions; these are only a few. You can also create your own formulas, which we will try later. Usually, formulas should be followed by parentheses that contain cell locations for the computer to scan through and compute within. An example of a correctly-entered formula/function would look like this:

=SUM(A3:A15) (meaning, compute the SUM of numbers in cells A3 THROUGH A15)

or like this:

=AVERAGE(B2:D2) (meaning, compute the AVERAGE of numbers in cells B2 THROUGH D2)

or even this:

=B4*B5 (meaning, multiply the contents of cell B4 with the contents of cell B5)

A couple of things to notice: The colon serves as a hyphen, and means THROUGH. The asterisk or * means multiply.
Here are these and the other main math operators:

+ addition
- subtraction
* multiply
/ divide
: through

Once you hit enter or tab, or once you move the rectangular cursor bar, the computer actually does the computations for you and prints the result in the cell location where you typed the formula. However, if you move the cursor bar back to that cell and look at the top of your spreadsheet in the editing field, you should see the actual formula appearing above in the formula bar, with the result displayed down in the cell where the cursor is resting – this helps to check to see if the formula or function was entered correctly. The formula and/or function will appear in the editing field and the result will appear in the cell.

**Headings:** The letters designating columns are called headings. You can choose to view or not view them, or to print or not print them.

If you’re NOT in *Microsoft Excel*, then…enter *Microsoft Excel* to work on the following pages.

Try the following:

1. Type the following numbers into the first five cells of your spreadsheet.

   |   |   |
---|---|---
1 | 10|
2 | 20|
3 | 30|
4 | 40|
5 | 50|
2. Click your cursor in empty cell A6
3. Click the AUTOSUM button in the HOME tab of the Ribbon at the top of the screen.

![Excel Screen with Formulas](image)

4. You should see a formula with moving lines around the entire selected cell – this is Excel's way of "asking" you if you want it to perform this function. To tell Excel "Yes, go ahead and add this column of numbers," press the ENTER key on the keyboard. To tell Excel "No," press the ESC [escape] key on the keyboard.
5. Next, in cell A7, type the following, and press the ENTER key when finished:

   \[=a6-a4\]

6. Notice how we preceded the formula with an equals sign.
7. Move your cursor back to cell A7. Look in the formula bar at the top of the screen. You should see your formula appearing there, with upper case letters where you had typed lower case. This is fine. Excel will take care of those details for you. You can always see the formula that produced the result you see in the cell by doing this simple task. It's like viewing an x-ray of the cell where the result appears.

   WHERE YOUR CURSOR IS determines the actions and what you will see, as well as what tasks you can do.

8. Move your cursor to cell A8 and try a multiplication formula like the following:

   \[=a5\times a2\]

9. Now try a division problem by putting this formula into cell A9.

   \[=a6/a1\]

   Hopefully this exercise gives you the idea of how the spreadsheet works especially with math functions and formulas.

**Note:** Parentheses are not needed in the instances shown in steps 5, 8, & 9, but if they are used, the formula will still work. **Think:** Why is this so?
An Introduction to **MS Excel 2016 (similar to MS Excel 2013)**

1. **Ribbon Interface**
2. **Saving your work**
3. **Opening your work**
4. **File Tab and other Tabs on the Ribbon**
5. **Quick Access Toolbar**
6. & 7. Experiment with some already-created Excel workbooks.

Bottom Line: *Many things are still the same – just re-arranged. If you haven’t already, learn UNDO!*

1. **Ribbon Interface and tabs**
   a. The user interface used by many of the **MS Office 2013 and 2016 products** (such as **Word, Excel, PowerPoint, and Access**) is called the “Ribbon,” an interface introduced with **MS Office 2007 products** and carried through to **MS Office 2010, 2013, and now 2016**. There are less menus and word choices – you’ll notice things are much more visual, and “like” tools will be grouped together. Here is a diagram of the typical beginning screen in **Excel**.

   ![Ribbon Interface Diagram](image)

   b. Menus and toolbars from 2003 are now arranged on a **Ribbon** with **Tabs** of similarly-grouped regions or groups of buttons. **Contextual tabs** (sometimes called **tools**) appear only under certain circumstances, such as when a picture is selected or clicked on.

c. The **tabs** in **Excel 2016** are: **Home, Insert, Page Layout, Formulas, Data, Review, View**

d. Many users of earlier versions of **Excel** have found that the ribbon layout is very intuitive and makes work faster since similar regions of logically-grouped buttons of use are bundled together. Note that you do **not** get a **Live Instant Preview** of what the text would look like, whereas in PCs with the **Windows version of Excel**, you **will** get a live instant preview. Also, there is **no** mini toolbar on the Mac **Excel** version, and there is a mini toolbar feature on the **Windows version**.

e. The same 3 buttons are in the top left-most portion of the screen: **Minimize, Restore (Resize), and Close**.

f. **Features?** In addition to the **Ribbon** interface, you will notice the **Zoom Slider**. Try it out – it’s at the bottom of your screen instead of appearing as a drop-down menu at the top. You can also press **CTRL** and twirl the mouse wheel while the mouse is on the work area to zoom in and out of your screen.
2. **Saving Your Work:** Saving your work is a little different, but not much.
   a. Use the **File Menu** detailed below in #4.
      i. **Saving within MS Excel 2016** for use in MS Excel 2007 and higher, adds a new file extension: .xlsx -- four letters instead of three, with an x at the end of the extension. This file will not open automatically in earlier versions of Excel (such as 2003); however, you can download an optional converter for an older version of Excel if need be.
   b. **Saving within MS Excel 2016** for use within Excel 2016, 2010, or 2007 is fine. No changes needed.
   c. **Saving within MS Excel 2016** for use within EARLIER versions of Excel is an option – save as an Excel ’97-2003 document – this way you can open the document in ANY Excel version including 2016.
   d. Be conscious of how you save a document – You can choose to save a document for an older version of Excel by choosing the appropriate option from the **SAVE AS** option from the File Tab, which we will look at shortly.

3. **Opening Your Work:** What’s New? Opening your work is a little different, but not much.
   a. Use the **File Menu** detailed below in #4.
   b. Opening files in MS Excel 2016 that were created in earlier versions of Excel – No problems noted. Opening files in MS Excel 2016 that were created in MS Excel 2016 – No problems noted.

4. **File Menu**
   a. Notice all the options in the menu that are file-related, such as close, Import, Open, and others.
   b. Once you choose **Save As**, the dialog box below appears, allowing you to 1) name your file 2) select where to save it and 3) select the type of file to save it as.

5. **Quick Access Toolbar**
   a. This can be programmed to hold whatever buttons you prefer. It’s really your own customized Toolbar. By default, Excel 2016 automatically has three buttons ready for your use. They are:

   ![Quick Access Toolbar](image)

   - **Save (not Save As)**
   - **Quick Access Toolbar (below)**
   - **Undo**
   - **Redo**
   - **Add commands from here**

   b. To add commands or buttons of your own liking or choosing, click the drop-down arrow to the right of the toolbar. You can then select any shortcut you prefer. Here is a diagram of your options at the top of page 6. Notice the checkmarks by the default toolbar buttons. **More Commands** is a choice at the bottom of the menu. (see next page)
Now try this!

6. Experiment with already-created Excel documents
   a. Insert the flash drive attached to any library computer.
   b. Click File.
   c. Click Open.
   d. Scroll on the left until you see “DISKGO” or removable disk, and click once.
   e. Double-click the Excel folder
   f. Double-click (or click once on, then click the OPEN button) CLASSLIST.XLS Notice the file extension. Was this file created in an earlier version of Excel? How can you tell?
   g. Try adding names and grades from the handout in class – fill in columns A-D only.
   h. Click your mouse on the last figure in column E. Look in the formula bar to see if there is a formula.
   i. You may notice that the MAX, MIN, and AVG columns are computed automatically. If not, try the next set of steps; otherwise, skip ahead to step l.
   j. Use the autofill handle (small black box in the lower right corner of the cell) and drag downward by keeping the left mouse button pressed. Did the formula fill in properly for the new student(s) you added? Hopefully yes.
   k. Do the same with the Max and Average columns.
   l. Try highlighting the entire spreadsheet.
   m. In the Font group, still on the Home Tab of the Ribbon, click the drop-down menu for font color, and click one to try it. Click UNDO. Repeat if desired.
   n. Try hovering your mouse over similar areas such as Conditional Formatting in the Styles group or region of the same Home Tab. Click to try one, then click UNDO. Repeat.
   o. What are the margins of this spreadsheet? To find out, click the Page Layout Tab in the ribbon, then click Margins. Click CUSTOM MARGINS at the very bottom of the dialog box to see.
   p. Is there a Header on this spreadsheet? Click the Insert Tab and click Header and Footer. Click the Normal view button (bottom of the screen) to view your screen without the header (or footer).
   q. Click File. Slide the mouse to Save AS and click on DISKGO (on the left side of the screen). On the next dialog box that appears, notice the new file extension that has been added to the file name. Choose from the “Save as File Type” dropdown menu, the choice of Excel Workbook .xlsx. Click save.
   r. Close out of Excel. Open FINDER and locate your most recently saved version of classlist (remember it is in Excel Documents folder on the DISKGO flash drive). Close it, and re-open the 2003 version. Did both open successfully? Were you able to see both files in the folder?
A glimpse of the first four tabs in the ribbon in *Excel 2016:*

**Home Tab:**
Here is a snapshot of the groups on the **Home Tab.** Usually you will return to the Home Tab for things such as font changes or for text adjustments and alignments.

**Insert Tab:**
Here is a snapshot of the groups on the **Insert Tab.**

**Page Layout Tab**
Here is a snapshot of the **Page Layout Tab.**

**Formulas Tab**
Here’s a snapshot of the **Formulas Tab.** Notice that the groups on this tab do not have the small dialog box launcher.
7. **More Exercises: Finishing and Charting a spreadsheet.**

   a. Open the spreadsheet called, *Zale's Simplified.xls* from the DISKGO Excel Documents folder.

   b. Enter the following formulas in these cells (include equals sign – upper or lower case is acceptable.)

      | Cell   | Formula          |
      |--------|------------------|
      | E2     | =d2*b2           |
      | F2     | =c2-d2           |
      | G2     | =f2*b2           |

   c. Next, carry the formula down (relative referencing) by using the autofill handle (small black box) in the corner of the selected cell. In this case, click once on cell E2 to start.

   d. Place your mouse on the autofill handle noticing the mouse now becomes a small black cross.

   e. Drag the autofill handle down to row 5 and release. Notice how the formulas fill in, just as they did in prior versions of Excel.

   f. Do the same for cells F2 and G2.

   g. Click the Autosum button: Σ in the Home tab of the ribbon, and hit the Enter key on the keyboard. (If you see a series of #### symbols, it simply means your column needs to be wider to accommodate the number. Double-click on the line between the letters E and F in the column area of the screen. That should widen the column enough.) Repeat for cell G6.

   h. To create a quick chart, highlight the data (including column titles) in cells A1 through A5 then hold the CTRL key down and highlight the data in cells C1 through D5.

   i. Click the Insert Tab on the Ribbon. In the Charts Region click Bar. Select the first bar chart.

   j. Notice the new Chart Design contextual tab as well as a new Format tab in the title bar just above the ribbon. Click the Switch Row/Column. These new tabs only appear when you have a chart in the works on your screen, and it is selected. Experiment with the toolbar options to dress the chart up even further.

   k. Highlight or select the entire spreadsheet including the graph. Click the Page Layout tab, then click the Print Area command, then Set Print Area.

   l. Look at a preview of your work by clicking on File, Print from the App Menu above the ribbon. Return to the editing screen by clicking cancel on the print dialog box.
LESSON 1 – CLASS LIST SPREADSHEET

Type in the CLASS LIST spreadsheet on the next page, but refer to this page for specific instructions. Be in or select Microsoft Excel from the Windows screen and create a NEW BLANK WORKBOOK.

1. **Enter** the heading, CLASS LIST, as a HEADER by doing the following:
   
   Click the INSERT tab on the ribbon, then HEADER. You will see a box at the top of the screen.
   
   Type CLASS LIST, then click in the cells below the title to view the screen. Change the font and size as well by highlighting CLASS LIST, clicking the HOME tab, and changing font size and selecting bold. Click the VIEW tab and click NORMAL when done. You should see your screen without the header, and a vertical dotted line. Beyond the dotted line, material would print to a second page.

2. **Widen** column A by doing the following:
   
   Using the mouse, point at the line between columns A & B, in the top gray row of the screen. Your mouse should turn into a line with an arrow through it, allowing you to drag the lines left or right depending on if you need to widen or shrink a column. “Guestimate” the size. (If you double-click the line, it will automatically adjust to the widest entry typed into the column thus far.) Click the HOME tab when you are done.

3. **Type** the title of each column in caps. Hit the tab key after each title to advance to the next column.
   
   Make sure you are putting a separate title in each column by typing a title, hitting the TAB key, then typing the next title, hitting TAB again, etc. **Widen** the columns AFTER you type them in.

4. **Boldface, underline, and center** each of the column titles you entered by:
   
   Moving the cursor bar home to the first title (NAMES). Look for the white cross to appear.
   
   Highlighting across the row with the mouse (remember the first cell will always be white when highlighting in a spreadsheet while the rest will be dark and you will be using the white cross).

   Click the B, U, and center align buttons in the HOME tab of the Ribbon. **Widen** your columns.

5. **Enter** the names. First move to cell A2, type a name, then use the down arrow key or the enter key to move to the next location for the next name. **Continue working down** in that name column.

6. **Type** the grades for columns B, C, and D ONLY, in the same manner as in step 5. You will notice that once you leave a cell, the entered number goes flush right. This is normal, and helps the computer keep the figures properly aligned for future computations. Use the number pad if you have one, to enter the grades, as it will save you time and you will be able to work faster.

7. **Enter** the following formulas in JANE SMITH’S row only, making sure each formula goes under the proper column title. The computer will then figure the results once you leave each cell.

   =MAX(B2:D2) =MIN(B2:D2) =AVERAGE(B2:D2)

8. **Now fill** in everyone else’s results by
   
   Returning to Jane Smith's maximum grade in cell E2 by clicking in cell E2.
   
   Autofilling the column starting with E2. To do this, click and hold the mouse button down on the AUTOFILL handle (black cross appears over a tiny black box in the corner of the cell) and slide the mouse all the way to the end of the column in line with where the names end. Repeat for the minimum and average columns, and after doing the average column, keep the highlight on, and click the DECREASE DECIMAL button. Your decimals should get “under control”

9. **Alphabetize** the names by doing this:
   
   Return to cell A2 (JANE SMITH).
   
   Highlight (use white cross, not black) all columns AND rows for the students and their grades, excluding the column titles in the top row. (expand the selection appears if you haven’t selected all – choose it if necessary so you won’t lose data that accompanies each name!)

   Click the DATA tab, and click the small A-Z button.

10. **Set the Margins** by clicking the PAGE LAYOUT tab, then Margins, Custom Margins. Make the left and right margins ¼" and the top & bottom ¾" and click “center horizontally.” Click the SHEET tab, and click “print gridlines.”

11. Highlight entire spreadsheet, click PAGE LAYOUT, PRINT AREA, SET PRINT AREA. Click File and Save your work to the flash drive if you want, and print.
<table>
<thead>
<tr>
<th></th>
<th>NAME</th>
<th>GRADE 1ST</th>
<th>GRADE 2ND</th>
<th>GRADE 3RD</th>
<th>MAX GRADE</th>
<th>MIN GRADE</th>
<th>AVG GRADE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>SMITH, JANE</td>
<td>88</td>
<td>85</td>
<td>90</td>
<td>90</td>
<td>85</td>
<td>87.67</td>
</tr>
<tr>
<td>3</td>
<td>GARVEY, TODD</td>
<td>87</td>
<td>96</td>
<td>99</td>
<td>99</td>
<td>87</td>
<td>94.00</td>
</tr>
<tr>
<td>4</td>
<td>WILLIAMS, OSCAR T.</td>
<td>91</td>
<td>88</td>
<td>89</td>
<td>91</td>
<td>88</td>
<td>89.33</td>
</tr>
<tr>
<td>5</td>
<td>LANSBURG, ANGELA</td>
<td>88</td>
<td>77</td>
<td>95</td>
<td>95</td>
<td>77</td>
<td>86.67</td>
</tr>
<tr>
<td>6</td>
<td>WICK, MARIA</td>
<td>89</td>
<td>69</td>
<td>76</td>
<td>89</td>
<td>69</td>
<td>78.00</td>
</tr>
<tr>
<td>7</td>
<td>RASS, TIMOTHY G.</td>
<td>67</td>
<td>78</td>
<td>89</td>
<td>89</td>
<td>67</td>
<td>78.00</td>
</tr>
<tr>
<td>8</td>
<td>KATT, HENRIETTA</td>
<td>79</td>
<td>69</td>
<td>79</td>
<td>79</td>
<td>69</td>
<td>75.67</td>
</tr>
<tr>
<td>9</td>
<td>FEATHER, HEATHER</td>
<td>84</td>
<td>90</td>
<td>88</td>
<td>90</td>
<td>84</td>
<td>87.33</td>
</tr>
<tr>
<td>10</td>
<td>SHORT, HENRY W.</td>
<td>72</td>
<td>88</td>
<td>71</td>
<td>88</td>
<td>71</td>
<td>77.00</td>
</tr>
<tr>
<td>11</td>
<td>LONG, TAMMY T.</td>
<td>77</td>
<td>88</td>
<td>93</td>
<td>93</td>
<td>77</td>
<td>86.00</td>
</tr>
<tr>
<td>12</td>
<td>CANDLE, ALAN</td>
<td>86</td>
<td>78</td>
<td>89</td>
<td>89</td>
<td>78</td>
<td>84.33</td>
</tr>
</tbody>
</table>
LESSON 2 -- SPREADSHEETS

Type in the POPULAR GOVERNMENT BROCHURES spreadsheet on the next page, but refer to this page for specific instructions. Begin typing after making sure you are in the MICROSOFT EXCEL 2016 program.

---------------------------------------------------------------------------------------------------
---------------------------------------------
1. Enter the heading, POPULAR GOVERNMENT BROCHURES, as a HEADER by doing the following: Click the INSERT tab on the ribbon, then HEADER and FOOTER, and type the title in the box provided. Make the title Bold, and a larger font (see the Home tab). Click the VIEW tab on the ribbon, then NORMAL from the workbook views group.

2. Widen all four columns
   Move the cursor bar to the appropriate column and make sure the highlight is turned off. Stretch each column by sliding the mouse to the line between each column letter, hold the left mouse button down, and slide the mouse to move the line to whatever width you want. Change the other column widths the same way or “guestimate” with the mouse (prior lesson).

3. Type the column titles of each column in caps. Hit the tab key after each column title to advance.

4. Boldface, underline, and center each of the column titles you entered by: Moving the cursor bar home to the first title (TITLES). Highlighting (white cross) across the row. (remember the first cell will be white, the rest dark) Click the B, U, and center align buttons in the HOME tab on the ribbon for Bold, Underline, Center

5. Program each column as follows: Highlight column B from cell B2 to B10. On the HOME tab in the ribbon, click the dropdown arrow in the number format drop-down menu, and choose more number formats at the bottom of the list. Choose Currency, then 2 for number of decimals, and a $. Click OK. ((Repeat for column D.)) Highlight column C and then click the same option (more number formats), and choose Number, then type 0 in the "Number of Decimals" field. Check the box that says to use a 1,000 separator (to insert commas between every 3 digits). Click OK.

6. Enter the brochure titles. First move to cell A2, type a title, then use the down arrow key or the enter key to move to the next location for the next title. Continue working down in that column.

7. Enter the figures in columns B and C only. Work down in the columns, like you did with the titles. Do not type dollar signs or commas; only type decimal points with figures where needed.

8. Type the formula: =B2*C2 in cell D2, under the PROFIT column. Hit enter.

9. Fill in the remaining profits by returning to cell D2 and:
   Autofill the column starting with this cell (D2) as a reference (relative referencing).
   (use the black cross when you point at the autofill handle – the black box in the right hand corner of cell D2)

10. Alphabetize the titles by doing this: Return to cell A2 (INFANT CARE)
    Highlight this column (white cross) and the data in all the other columns, but exclude the column titles that were typed on row 1.
    Click the DATA tab, and click the small A-Z button.

11. Preview your spreadsheet by clicking File, then PRINT. Look for four columns on one page. If four columns do not appear, re-adjust the margins (step 12). Click the Home tab to return to editing.

12. Set the Margins by clicking the PAGE LAYOUT tab, then MARGINS. Under CUSTOM MARGINS at the very bottom of the drop-down menu, make the left and right margins ½” by typing .5. Preview again to make sure four columns appear on one page.

13. Highlight entire spreadsheet and click the PAGE LAYOUT tab. Click PRINT AREA, click SET PRINT AREA. Save & Print your spreadsheet onto the flash drive using File, Save As.
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TITLE</td>
<td>UNIT COST</td>
<td>NUMBER SOLD</td>
<td>PROFIT</td>
</tr>
<tr>
<td>2</td>
<td>INFANT CARE</td>
<td>$0.20</td>
<td>14,824,275</td>
<td>$2,964,855.00</td>
</tr>
<tr>
<td>3</td>
<td>YOUR FEDERAL INCOME TAX</td>
<td>$0.75</td>
<td>12,984,830</td>
<td>$9,738,622.50</td>
</tr>
<tr>
<td>4</td>
<td>PRENATAL CARE</td>
<td>$0.20</td>
<td>8,913,527</td>
<td>$1,782,705.40</td>
</tr>
<tr>
<td>5</td>
<td>YOUR CHILD FROM 1 TO 6</td>
<td>$0.20</td>
<td>6,627,022</td>
<td>$1,325,404.40</td>
</tr>
<tr>
<td>6</td>
<td>YOUR CHILD FROM 6 TO 12</td>
<td>$0.55</td>
<td>3,183,627</td>
<td>$1,750,994.85</td>
</tr>
<tr>
<td>7</td>
<td>TAX GUIDE FOR SMALL BUSINESS</td>
<td>$0.75</td>
<td>3,171,326</td>
<td>$2,378,494.50</td>
</tr>
<tr>
<td>8</td>
<td>STRICTLY FOR TEENAGERS</td>
<td>$0.05</td>
<td>2,977,650</td>
<td>$148,882.50</td>
</tr>
<tr>
<td>9</td>
<td>YOUR SOCIAL SECURITY</td>
<td>$0.15</td>
<td>2,149,205</td>
<td>$322,380.75</td>
</tr>
<tr>
<td>10</td>
<td>RESCUE BREATHING</td>
<td>$0.05</td>
<td>1,954,850</td>
<td>$97,742.50</td>
</tr>
</tbody>
</table>
LESSON 3 -- Spreadsheet & Charting Exercise

Spreadsheets in MS Excel 2016

Create the spreadsheet (spreadsheet A) that you see on page 15, and later, the chart you see on page 17 by following the steps below.

1. Open MS Excel.
2. Click the PAGE LAYOUT tab on the ribbon, and then select MARGINS, CUSTOM MARGINS. Put half-inch (.5) margin settings for left and right as seen in the dialog box below. Click the box to Center on Page Horizontally. Click OK.

3. Still in the PAGE LAYOUT tab, click the ORIENTATION button and choose "Landscape." This is so that the spreadsheet will be printed horizontally on the page, to fit all the columns, instead of in the usual portrait fashion.
4. Click the INSERT tab on the ribbon, and choose HEADER AND FOOTER. Click inside the centered box on the spreadsheet and type “Zale’s Amounts Thus Far as of” followed by today’s date. Next, highlight or select your text. Choose a font and size that works well from the HOME tab, and also choose bold if you’d like. Clicking someplace BELOW the header on your screen allows you to continue working in the spreadsheet while viewing the header at the same time. If you wish to close out of the header view and have it NOT visible while you work, click below the header, then click the VIEW tab, then NORMAL. The header will still remain in your spreadsheet, but you won’t see it while you work.
5. Click the PAGE LAYOUT tab, and in the SHEET tab, click the checkbox to PRINT GRIDLINES.
6. Click inside cell A1, and type the column titles you see listed on the spreadsheet. Make sure each title goes into its own column, which means you will need to hit TAB after typing the first title for column A, then proceed with the next title, hit TAB, and so forth.
7. Center and boldface these titles across the first row by highlighting or selecting (use white cross) the titles with the mouse, then click the B, U, and center align buttons in the HOME tab on the ribbon.
8. You may need to adjust the column widths. The easiest way is to use the mouse to double-click the line between the column letters in the gray area above the white spreadsheet cells or drag the lines with the mouse provided your cursor is in the gray area where the column letters are located. The column width will “snap” to the longest entry currently in the column. Your mouse will take on a new shape – a line with an arrow. This is the column or row adjusting tool.
9. Next, highlight or select (use white cross) the entire first row, and click the HOME tab on the ribbon. In the STYLES group, select CELL STYLES and choose a color for the cells you have highlighted.
10. Highlight or select (use white cross) cells B2 through B5. On the HOME tab and in the number format drop-down menu, click choose CURRENCY in the dialog box that appears, putting 2 for decimals. Click OK. Do the same for cells E2 through E6, and G2 through G6. This will “program” the cells to convert numbers into currency, saving you time so you don’t need to actually type a dollar sign.
11. Enter the data in columns A, B, C, D, and F only, and do not type any dollar signs. They will appear automatically.
12. If you mistakenly entered ALL the data in the entire spreadsheet, erase what you have entered in columns E and G (highlight and hit DELETE the numbers).

13. Enter the following formulas in these cells (include equals sign -- upper or lower case is acceptable):

- In E2 type: \( =d2\times b2 \)
- In F2 type: \( =c2-d2 \)
- In G2 type: \( =f2\times b2 \)

14. Next you will carry the formula down by using the **fill-down handle** in the corner of the selected cell, in this case, cell E2. (see below). Click first in cell E2, where the finished result should appear from your formula. Look for the small black box in the right-hand side of the cursor, and place your mouse on it noticing the mouse now becomes a small black cross (not visible in the diagram below). Next, drag the fill-down handle from cell E2 to cell E5 and release the mouse button. Notice that all the cells should be filled with appropriate data. The formula for each cell will appear in the formula bar once you click on any particular cell.

15. Do the same for cells F2 to F5, and from G2 to G5 and fill the cells.

16. Place your cursor in cell E6 and click the **AUTOSUM** button: \( \sum \) then enter. Repeat for cell G6.

17. Highlight or select (use white cross) the text in cells D8 and F8, then boldface, italicize, and align them flush right.

18. Highlight or select (use white cross) the figures in cells B2 to B5 and experiment with the buttons that are for **INCREASING INDENTS** or **DECREASING INDENTS** in the Alignment Group on the HOME tab of the ribbon. Now do the same in columns E and G. What happens with the dollar signs in those cases? *(Note: If you try to get the dollar signs to appear TOO close to the figures, you will see a series of \#\#\# symbols, giving the impression that your numeric entries are gone; however, they are not. If this happens, click the other indents button (decrease)—figures should re-appear.)*

19. Go to File and click PRINT and look at the preview -- check that all the columns (through G) appear on one page, and also look for your header. You may have to tweak your spreadsheet to make it fit. First, click the Page Setup words while you're in PREVIEW. Note: you can also switch back and forth from LANDSCAPE to PORTRAIT at any time, not just before creating the spreadsheet -- visit the PAGE LAYOUT tab and check that LANDSCAPE has been selected already (see instruction 2 above). Margins can also be changed here if you want to. Center the page horizontally by clicking the MARGINS tab and looking for the checkbox for that feature. Click the Home tab to return to editing.

20. Highlight or select (use white cross) all of your data in the spreadsheet, and click FILE, PRINT AREA, SET PRINT AREA. This marks off the area you want to print so that several blank pages will not unnecessarily print.

21. Click FILE, SAVE AS, and name and SAVE your work to the FLASH DRIVE as an .xlsx document, then click FILE, and PRINT your spreadsheet if you’d like.

Now try for different styles and effects on your spreadsheet. (You do not have to create separate spreadsheets; simply “play” with the one on your screen. Since it’s already saved, anything you do to it will not affect it unless you SAVE again.) Highlight or select (using the white cross) the ENTIRE spreadsheet. (Use shift + any arrow key method if the mouse is too fast -- ask instructor for help) then slide the mouse to these buttons on the HOME tab, and experiment by going to various choices on these buttons – you will have to click on a button to actually see its effects. Click UNDO if you wish to return to making selections again, and changing your mind.
LESSON 4 -- Spreadsheet Charting Exercise
Charts in MS Excel 2016

Microsoft Excel is a powerful spreadsheet program. Not only can it help organize data, it can perform almost any mathematical formula you need, be it simple or complex. You can also chart the information you place in a spreadsheet. This is just the tip of the iceberg as to what Excel can do. Learn more below.

First, important to note is that whenever you open MS Excel, the program gives you one blank worksheet as part of the opening screen. (in earlier versions of Excel, the default was three blank worksheets) This sheet is part of one workbook. You can always add sheets to, or delete sheets from the workbook. Secondly, when highlighting or selecting things on your spreadsheet, use the white cross, and remember that the first area you highlight will always be white as a reference to where you started, and the remainder of the data will be highlighted in blue, gray, or purple. That is normal. For now, look at the bottom of your spreadsheet (or, technically, your workbook) that you saved. Let’s learn how to add and delete sheets.

Make sure to have your spreadsheet open on the screen.

1. To add a sheet to your already-opened workbook, click the button next to sheet 1 to INSERT a WORKSHEET. Notice you should now have two worksheets. You can use the mouse to move or drag the sheets into the right order. Try it now. (press & hold the left mouse button – drag the sheet)
2. To delete a sheet -- right-click on the tab labeled “Sheet 2” and left-click or choose DELETE from the menu that appears. You can always right-click and choose RENAME as well, and give the tab a more meaningful name.

CHARTING: Let’s imagine we want to create a chart to compare Zale’s (Quantity Received) with the actual number of items sold (Quantity Sold).

1. Highlight or select (using the white cross) the data in columns A1 through A5, then press and hold the COMMAND key while selecting both QUANTITY RECEIVED and QUANTITY SOLD in cells C1 through D5. Click the INSERT tab and in the CHARTS group, click BAR, then Clustered Bar. Note we are including the column titles to help in our chart creation.
2. Notice the Contextual Tab that appears once you make the chart for CHART TOOLS. (see below) and click the various sub-tabs such as CHART DESIGN or FORMAT for various “tweaks” you can do to the chart.
Chart Title: In the CHART DESIGN contextual tab on the ribbon, if no title is currently on the chart, click the ADD CHART ELEMENT button on the far left and click the Chart Title button and click where you would like the title to go. Click then type inside the title box and label the chart as follows:

Comparing Quantity Received (blue) with Quantity Sold (red)

Still in the ADD CHART ELEMENT button, do the following:

- Point to the Legend option, click RIGHT from the fly-out menu.
- Point to the Data Labels button and click CENTER. Notice where the numbers go.
- Experiment with different looks – click the FORMAT tab and try different choices there. Or Styles.

The chart should now behave much like a piece of clipart. You can resize it, move it, and even double-click on parts for changes.

3. Highlight or select (white cross) ALL of the spreadsheet data including the chart. Click the PAGE LAYOUT tab on the ribbon, then PRINT AREA, SET PRINT AREA. Then click File, then PRINT. Notice that all of the spreadsheet should be shown. Close out of the print and preview screen by clicking the HOME tab. Click once on JUST the chart. Now click again on the File tab and select PRINT, and look again at the automatic preview. What happens? You should see only the chart, enlarged to fit nicely on a piece of 8½” x 11” paper – just perfect for a science fair project request! So WHERE your mouse is clicked affects what is actually printed in your spreadsheet.

Summary: You can print the spreadsheet AND the chart on the same page, OR you can print them separately.
### Zale’s Amounts Thus Far as of 12/15/2017

<table>
<thead>
<tr>
<th>Item</th>
<th>Unit Price</th>
<th>Quantity Received</th>
<th>Quantity Sold</th>
<th>Amount thus Far</th>
<th>Amount Left Over</th>
<th>Amount not-yet-seen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rings</td>
<td>$20.00</td>
<td>200</td>
<td>130</td>
<td>$2,600.00</td>
<td>70</td>
<td>$1,400.00</td>
</tr>
<tr>
<td>Necklaces</td>
<td>$50.00</td>
<td>150</td>
<td>100</td>
<td>$5,000.00</td>
<td>50</td>
<td>$2,500.00</td>
</tr>
<tr>
<td>Watches</td>
<td>$25.00</td>
<td>300</td>
<td>200</td>
<td>$5,000.00</td>
<td>100</td>
<td>$2,500.00</td>
</tr>
<tr>
<td>Earrings</td>
<td>$15.00</td>
<td>600</td>
<td>450</td>
<td>$6,750.00</td>
<td>150</td>
<td>$2,250.00</td>
</tr>
</tbody>
</table>

**Total Amount:** $19,350.00  **Total Amount not-yet-seen:** $8,650.00

---

**Comparing Quantity Received (blue) with Quantity Sold (red)**

- **Earrings:** 450 vs. 600
- **Watches:** 300 vs. 300
- **Necklaces:** 150 vs. 100
- **Rings:** 200 vs. 130

![Bar Chart](image)
Calculation operators in formulas

Operators specify the type of calculation that you want to perform on the elements of a formula. Microsoft Excel includes four different types of calculation operators: arithmetic, comparison, text, and reference.

**Arithmetic operators**  To perform basic mathematical operations such as addition, subtraction, or multiplication; combine numbers; and produce numeric results, use the following arithmetic operators.

<table>
<thead>
<tr>
<th>Arithmetic operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (plus sign)</td>
<td>Addition</td>
<td>3+3</td>
</tr>
<tr>
<td>– (minus sign)</td>
<td>Subtraction</td>
<td>3–1</td>
</tr>
<tr>
<td></td>
<td>Negation</td>
<td>–1</td>
</tr>
<tr>
<td>* (asterisk)</td>
<td>Multiplication</td>
<td>3*3</td>
</tr>
<tr>
<td>/ (forward slash)</td>
<td>Division</td>
<td>3/3</td>
</tr>
<tr>
<td>% (percent sign)</td>
<td>Percent</td>
<td>20%</td>
</tr>
<tr>
<td>^ (caret)</td>
<td>Exponentiation</td>
<td>3^2 (the same as 3*3)</td>
</tr>
</tbody>
</table>

**Comparison operators**  You can compare two values with the following operators. When two values are compared by using these operators, the result is a logical value, either TRUE or FALSE.

<table>
<thead>
<tr>
<th>Comparison operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>= (equal sign)</td>
<td>Equal to</td>
<td>A1=B1</td>
</tr>
<tr>
<td>&gt; (greater than sign)</td>
<td>Greater than</td>
<td>A1&gt;B1</td>
</tr>
<tr>
<td>&lt; (less than sign)</td>
<td>Less than</td>
<td>A1&lt;B1</td>
</tr>
<tr>
<td>&gt;= (greater than or equal to sign)</td>
<td>Greater than or equal to</td>
<td>A1&gt;=B1</td>
</tr>
<tr>
<td>&lt;= (less than or equal to sign)</td>
<td>Less than or equal to</td>
<td>A1&lt;=B1</td>
</tr>
<tr>
<td>&lt;&gt; (not equal to sign)</td>
<td>Not equal to</td>
<td>A1&lt;&gt;B1</td>
</tr>
</tbody>
</table>

**Text concatenation operator**  Use the ampersand (&) to join, or concatenate, one or more text strings to produce a single piece of text.
<table>
<thead>
<tr>
<th>Text operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp; (ampersand)</td>
<td>Connects, or concatenates, two values to produce one continuous text value</td>
<td>&quot;North&quot; &amp; &quot;wind&quot; produce &quot;Northwind&quot;</td>
</tr>
</tbody>
</table>

**Reference operators** Combine ranges of cells for calculations with the following operators.

<table>
<thead>
<tr>
<th>Reference operator</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>: (colon)</td>
<td>Range operator, which produces one reference to all the cells between two references, including the two references</td>
<td>B5:B15</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Union operator, which combines multiple references into one reference</td>
<td>SUM(B5:B15,D5:D15)</td>
</tr>
</tbody>
</table>
LESSON 5 –Mail Merge for Labels

Creating mailing labels by merging from an already-created list of multiple names & addresses.

In the Library's version of Microsoft Office, we will use MS EXCEL, a spreadsheet program that you allow you to put names and addresses into ordered columns and rows, in a sense serving as a database for our information. In using EXCEL, you will get a good idea of how a database would work and how to set up the basics. Learning what "FIELDS" actually are and how they are used can be gleaned by using the MAIL MERGE feature here, which essentially is a mini-database. Basically, you use 2 programs for the entire Mail Merge job: MS Excel 2016 and MS Word 2016. First, we will use MS Excel, and then MS Word.

Incidentally, a FIELD NAME is a general way of calling upon a list of specific names. For example, John, Mary, and Sue could be called "FIRST NAMES" as a field name. Smyth, Harrison, and Jones could be called "LAST NAMES." The idea is to enter specific names into a mini-database that we create using general names or FIELD NAMES and then merging these specific names via the FIELD NAMES into the form letter. You may have already done steps 1-3, and if you have, simply skip to step 4.

1. Go into Microsoft Excel.
2. Enter the following "titles" or "FIELD NAMES," one per column, as you see them here. Use your mouse to widen the columns as needed. Ask the instructor for assistance if necessary.
3. SAVE your list as “Friends List 1,” with your initials, on a Flash Drive or on your laptop. EXIT MS Excel.

<table>
<thead>
<tr>
<th>Title</th>
<th>Salutation</th>
<th>First Name</th>
<th>Last Name</th>
<th>Address</th>
<th>Address 2</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mr. &amp; Mrs.</td>
<td>Chuck &amp; Ann</td>
<td>Charles</td>
<td>Finster</td>
<td>87 Park Place</td>
<td></td>
<td>Johnstown</td>
<td>NY</td>
<td>12345</td>
</tr>
<tr>
<td>Mr.</td>
<td>Al</td>
<td>Allan</td>
<td>Candle</td>
<td>1345 Wicker Drive</td>
<td></td>
<td>Portland</td>
<td>ME</td>
<td>23456</td>
</tr>
<tr>
<td>Mr. &amp; Mrs.</td>
<td>John &amp; Petra</td>
<td>John</td>
<td>Smythe</td>
<td>34 Carriage Way</td>
<td>RR#2</td>
<td>Tulip Heights</td>
<td>MO</td>
<td>34921</td>
</tr>
<tr>
<td>Ms.</td>
<td>Penny</td>
<td>Peneole</td>
<td>Phineas</td>
<td>29 Winston Heights</td>
<td></td>
<td>Windsor</td>
<td>CT</td>
<td>84921</td>
</tr>
<tr>
<td>Miss</td>
<td>Jen</td>
<td>Jennifer</td>
<td>Ripley</td>
<td>92 Arlington Road</td>
<td></td>
<td>NY</td>
<td>NY</td>
<td>51928</td>
</tr>
</tbody>
</table>

5. Click the Mailings Tab.
6. Click Start Mail Merge.
7. Click Labels.
8. In the “Label Options” dialog box that appears, select Avery Standard for Label Vendors, and the number 8160 Address for the Product Number as shown below. Click OK. You should see a full page of labels with “Next Record” showing on each label, except for the first one.

9. Click or be in the Home tab, and click the drop-down menu for the “Borders” button. Click “View Gridlines” and you should see label borders appear.
10. Click the Mailings tab once again.
11. Progress from left to right along the ribbon, and click Select Recipients.
12. Click Use an Existing List from the menu that appears.
13. **Locate and open** your “Friends List 1 [with your initials]” file on your flash drive or on your computer.
14. This popup window may appear, and you can click OK to proceed.

15. Next, you may see this screen appear – Type in the cell range as shown below `a1:i6` then click **OK**.

16. In the **“Edit Labels”** dialog box that appears, insert the following fields from the “Insert Merge Field” drop-down menu. The selections appear directly from your attached Friends List file, and reflect the titles you actually typed in your spreadsheet. Piece them together logically, inserting spaces between City and State, for example (see below), and hitting return on the keyboard to advance to another line. Click **OK** when done.

17. Click **Update All Labels**, then click **Preview Results** from the ribbon.
18. You can return to the **Page Layout Tab** at this point and work with spacing under the **paragraph region** if you are unhappy with line spacing. (0 point for each of the two options works fine – spacing before and spacing after a paragraph.)
19. Save at this stage if you anticipate making changes in the spreadsheet in the future. Changes can then be made to the spreadsheet in Excel, and will reflect in the labels if you open the saved labels document and proceed through the prompts.
20. In the **Mailings** tab, click **Finish and Merge** IF you intend to print, and click **Edit Individual Documents**. You can save at this stage, too, but if a change occurs, you will have to manually type it into this document for it to reflect a change.
LESSON 6 – Creating labels using ENVELOPES & LABELS option and adding a picture  
To create a sheet of the same label such as for return address, or one-address-only labels with a picture (without any merging from an already-established list).

Working with Labels for one address with a picture

Labels can be a lot of fun to work with, and using MS Word’s ENVELOPES & LABELS feature can be very useful. First of all, when purchasing labels, pay close attention to the AVERY number on the box (there are other brands, too, but AVERY is usually the state-of-the-art standard brand). This is a reference number you will need in order to select the label TYPE you are using. There are MANY different kinds and sizes of labels, some very large for mailing packages, some very small for creating return address labels, and so forth. Knowing the Avery number allows you to plug this information into the OPTIONS button on the ENVELOPES & LABELS dialog box that appears. Then the software will take care of the printing size. Let’s just simply locate the OPTIONS dialog box so you will know where it is. Then we will try other exercises afterwards.

1. Click the MAILINGS tab from the ribbon, then LABELS.
2. Type an address in the box provided.
3. Click the OPTIONS button. (here it is!) Look in the drop-down menu for the AVERY number you found on your box of labels (8160 is fine to use for now).
4. Click FULL PAGE OF THE SAME LABEL.
5. Click OK.

(Note that you could print only one label by selecting that option instead, and next telling the program in which column and row the empty label is located. So don’t throw away partially-used sheets of labels as you can use them in this manner.)

LESSON 7: To make labels with the same picture on them, do the following.
It is a little time consuming, but fun!

1. If you already have a screen of labels on your monitor, skip to step 8.
2. Exit and re-enter MS Word to start “fresh.”
3. Have a blank document on the screen.
4. Click the Mailings tab, click Labels.
5. Hit enter on the keyboard for a blank line of type, then type an address and then choose “full page of the same label.”
6. Click the OPTIONS button and select the correct label brand and product number. Click OK.

7. Click the NEW DOCUMENT button.
8. A screen showing the labels should appear.
9. Click inside a label. (Note: you COULD fill in the entire sheet by typing one label at a time if you wanted to or if you wanted to fill the sheet with pictures that you could cut out for stickers for whatever use.)
10. Select a picture by clicking the INSERT tab, then PICTURES and PICTURE FROM FILE. Click any picture then INSERT.
11. Next, click on the picture, and then look for the wrap text button to appear in the PICTURE FORMAT contextual tab. Choose Tight.
12. Resize and move the picture to where you want it. You can use the mouse to move the picture, or you can press CTRL + SHIFT while holding the picture with the left mouse, and sliding the mouse.
13. Click at the end of the address so you see a flashing cursor. Both picture and address should be inside the label. No highlighting needed.
14. Click MAILINGS, LABELS, then FULL PAGE OF SAME LABEL. You won’t see the picture at this point.
15. Click the OK button.
16. A full page of the same address should appear with the same single image on each label.
17. Note: You can put different pictures on each label, but it is time consuming. Just click on an image and tap DELETE on the keyboard, and repeat the insert steps (9-11). Repeat the steps for another picture starting with step 9 above. See if you can fill an entire row of labels with various pictures.
18. For better fitting text and graphics, you can adjust the lines of text and the spacing above the lines of text by highlighting the blank line we inserted in label 1, and then selecting a smaller point size to make that space smaller.


A tip for printing labels: Print a sample sheet of labels first on plain paper, (1 page) and hold the printout up to a blank labels sheet. If the printout looks like it will match the labels sheet, then put the labels sheet into the printer and print. This will save costs, too, as label sheets are expensive.
Can you reproduce this spreadsheet and chart? *Hint*: Data entry for the first 7 columns, then in column 8, enter one formula and use relative referencing to fill it down. Make sure to use a different formula for the class average, however.
1. Enter the data, including column headings, WITHOUT any line spaces as shown above, and make sure to put the TIME in the first column. **Hint: for TIME, enter 0 then 30, hit enter, highlight both numbers and use AUTOFILL.**

2. Highlight or select both columns of data including the column titles.

3. Click the INSERT tab, and in the CHARTS group, click SCATTER, and of the five types of scatter charts shown, find and click on SCATTER WITH SMOOTH LINES.

4. Notice the new contextual tabs appearing at the top of the screen labeled “CHART DESIGN,” and “FORMAT,” located above the ribbon once your chart is selected or highlighted.

5. In the CHART DESIGN TAB, click the ADD CHART ELEMENT command circled here, to see the elements to add to the chart. Explore all of the elements and inspect for the following:

6. Under AXES, PRIMARY HORIZONTAL and PRIMARY VERTICAL should already be selected with checkmarks. Click MORE AXIS OPTIONS to reveal this task pane.

7. Under Bounds, change Maximum to 270 (the highest time amount from our data) and make sure the minimum is 0.

8. Change major unit to 30, since the time increments in seconds jump by 30, consistently, through our data.

9. Under AXIS TITLES, select PRIMARY HORIZONTAL, then repeat to select PRIMARY VERTICAL.

10. Under CHART TITLE, ABOVE CHART should already be selected with a checkmark.

11. Click inside the title fields and type the appropriate titles as seen above.

12. Under LEGEND, select RIGHT.
Understanding IMPORTANT Excel Concepts

The difference between Relative and Absolute Cell References in MS Excel

Relative

By default, in any spreadsheet program, once you write a formula and copy it, it will copy it RELATIVE to the cell it started in. Such as the spreadsheet we did with the grades, where we put one formula in for the MAX, one for MIN, and one for AVERAGE. When we highlighted down with the AUTOFILL tool, the formula changed RELATIVE to the first cell we highlighted. This was great.

Absolute

Use $ before column letter and/or before the row number as well to tell the computer in a formula that the cell reference is ABSOLUTE, and that you don’t want it to increment or change as you highlight to carry the formula to other cells. If you have a FIXED value in a particular cell that you use in a formula, that FIXED value should be referenced in the formula as an ABSOLUTE reference, and should not be treated as a RELATIVE reference as we did above.

This concept is SO crucial to understand among those who wish to use formulas and so forth in MS Excel.

Note: See page 29, Lesson 12 for a greater understanding of ABSOLUTE referencing.

*A tip: To show negative numbers, use parentheses or brackets rather than color ink in case you have to print your results on a laser printer.
LESSON 9: Order of Operations

*MS Excel* follows a rule when solving formulas called the “Order of Operations.” If more than one operator is used in a formula, *Excel* will follow a particular order to get the result.

The order of operations is...

- Parentheses
- Exponents
- Multiplication & Division
- Addition & Subtraction

Remember: Please Excuse My Dear Aunt Sally

If you see a complicated formula that looks like this:

\[4 + 8/2*7 - 2^3 + (3+4)\]

Excel will look at this first, for parentheses, and if present, will do what is in parentheses first.

So what would be done **FIRST** in the above example?

**FIRST** *(3+4)* because this operation is in parentheses. So far, we have...

\[4 + 8/2*7 - 2^3 + 7\]

**SECOND** will be the exponents *(2^3)*.

\[4 + 8/2*7 - 8 + 7\]

**THIRD** what is done is any Division or Multiplication found from left to right. So... 8/2 is done followed by its result of 4*7. Resulting in this...

\[4 + 28 - 8 + 7\]

**FOURTH** would be any Addition or Subtraction found from left to right. So... 4+28 is performed giving us 32, then from 32, subtract 8, giving us 24, and then adding 7 to 24 giving us 31.

\[32 - 8 + 7\]

\[24 + 7\]

**31** should be the final answer that *Excel* would give you. Try entering the formula above in an Excel worksheet, remembering to put an = sign in front. What did you get as a result?

Try this GCF Learn Free lesson (about 3-4 minutes) to re-enforce this important concept:
[http://www.gcflearnfree.org/excel2013/14](http://www.gcflearnfree.org/excel2013/14)
LESSON 10: Formatting cells

Another necessary aspect of MS Excel is knowing you can format cells. This allows you to do a number of things including:

- Displaying numbers in currency format
- Displaying a date in a particular way or format
- Forcing the computer to display zeroes in a zip code, for example, by choosing the “zip code” format.

The best way to format a cell or group of cells is to:

1. Highlight or select the cell or cells you wish to format.
2. Click the HOME tab on the ribbon.
3. Click the drop-down menu option where you see GENERAL, and select MORE NUMBER FORMATS at the bottom of the menu.
4. Look through the formatting options in the category list that appears under NUMBER, and make your selection such as is shown in this example here. In this case, SPECIAL was chosen. Next, select ZIP CODE in the Type options. This option allows for zip codes with a 0 as a first digit, so the 0 will actually appear when typing the zip code.

Note: You can also program the spreadsheet to accept numbers in a particular format. For example, if you had part numbers to enter, and they were to be in a format such as this:

34-7859-09

You would follow the steps above, but in step 4, choose CUSTOM and type in the following code:

```
#-##-##
```

This way, typing in a number such as 87965832 would yield the result: 87-9658-32 automatically, saving the person entering the numbers the work of typing in the dashes. Provided the correct number of digits was entered, the computer would be programmed to fill the highlighted cells with the format you commanded.

You can also control the number of decimals you wish to display in your number. This again, is done through FORMATTING CELLS such as described above.

A Tip: MS Excel can be used as a database program as well as a workbook/spreadsheet/worksheet program; however, if you plan to have 500 or more entries or individual names or records, it is best to consider using MS Access instead as your database.
LESSON 11: Data Manipulation and Filtering in MS Excel:

When using MS Excel as a database that needs sorting, select ALL your entries or else only a certain area might be sorted. You have up to 3 criteria to sort.

Filtering:

1. Open your CLASSLIST of names and grades. Click your cursor on the title AVERAGE and the first average grade in that column.
2. Click the DATA tab on the ribbon.
3. Click FILTER.
4. Click the drop-down menu that appears on the title, AVERAGE. Make a choice (such as smallest to largest) then see what happens.

Filter looks DOWN a column and can hide everything but what you see in the drop-down menu. De-select when you are done by clicking the FILTER button once again. FILTER is a nice, quick way to briefly analyze data. FILTER is a safer tool than many other tools.

Some tips:

- When creating a chart, it is best to highlight data consecutively and also, do not highlight empty rows or columns.
- You can put images in for patterns in a chart. Be creative.
- If you use PASTE SPECIAL instead of PASTE only, you can LINK objects such as charts, and automatically update them. Just plain old PASTE, when used from the INSERT tab, only returns a static image.
- Match your presentation style to your message and audience as well. For example, bar graphs are NOT good for motivating salespeople. Pie graphs are better because salespeople like to view themselves as part of a team.

LESSON 12:
Discovering more about Absolute Referencing

1. In MS Excel 2016, open the file, located on the flash drive, called “SALES”
2. Look at the figures in the spreadsheet. Land your cursor on cells D3, D4, and D5. Examine the formula for each cell. Are there any formulas that are in error? ____________________  Why? ______________
3. What happens if you autofill the formula in column E down the column? ________________ ________________________________________________________________
4. How can you correct the autofill problem? Answer: Use the ABSOLUTE REFERENCE technique of assigning dollar signs to each address component. For example, in the original formula in cell E3, use the formula =B$18*D3 THEN use the autofill feature. By assigning dollar signs ahead of the column letter (B) and the row number (18) portions of the cell address that contain a constant, in this case the tax percentage figure, the figure will remain constant throughout the autofill procedure.
5. Lastly, fix the dollar signs so they are closer to the figures in all of the columns. Hint: Highlight the figures then click the HOME tab on the ribbon and examine CURRENCY in the drop-down menu of the GENERAL tab.
LESSON 13: Part 1 – Computing Sums, Averages, and Standard Deviation in a Spreadsheet

This spreadsheet exercise came from a website (no longer available) and although it was originally designed for an older version of Excel, the concepts still apply in version 2007, 2010, and 2013. One thing to note is that blank rows are now discouraged in spreadsheet design. For this lesson, go ahead and leave the blank rows where you see them, but remember NOT to use blank rows, as a general rule of thumb, in the future.

2. Open a file called “Salespersons Commissions without formulas.xls” which is located in the Excel folder on your flash drive.
3. Using the white cross that appears with your mouse, highlight the area on the spreadsheet from B3 through E10, which will include all the monthly figures shown, as well as some blank space (one column) to the right of the figures, and 2 rows below them.
4. Click the Autosum button Σ from the HOME tab on the ribbon. You should see totals now appearing in column E, and in Row 10. Refer to the printed spreadsheet you see on page 33 to compare results.
5. Use a formula to figure out the average sales total from January through June, and compose it in cell B12. After hitting Enter, click back on the figure and use the AUTOFILL handle to drag to the right, filling in all cells from B12 through E12.
6. In row 13, figure standard deviation by using the formula: =STDEV and use the range for the first region’s six-month sales results.

LESSON 13: Part 2 – Using Logical Functions (IF statements) nested in our formulas. Ready to stretch your thinking? First, steps 1 & 2 outline a general theory of what we will do.

1. As the Furman exercise states on page 29, we want to create a formula that “makes a decision” about which commission rate to use based on the value of the total sales. Here is what we are thinking:
   - IF the total sales made for the six-month period for any given region is >100,000 then that region gets the larger commission of 6% as a reward. ELSE go on...
   - IF the total sales made for the six-month period for any given region is >80,000 then that region gets the 5% commission as a reward. ELSE go on...
   - IF the total sales made for the six-month period for any given region is <80,000 then that region gets the lowest commission rate of 3.50%

2. We also need to think about the Adjusted Sales area in Cell A15. What we want to do, is through a formula, tell the computer to analyze the totals in row 10, and if a total meets one of the requirements listed above, then take the total and from it, subtract the commission amount leaving the company’s actual adjusted sales figure. Note that this will NOT return what the salespersons or sales groups get in commission. This spreadsheet simply figures out what the COMPANY is getting based on subtracting the commissions.

3. Click inside of cell B15. Click CAPS LOCK to make things easier (however you can type the formula in either upper or lower case letters). Get ready to type a fairly long formula. This formula will be able to be used in cells C15, D15, and E15 once we type in into B15. There are 3 IF segments to the formula. The comma immediately after the first argument equates to the word “THEN DO THIS…” The second comma appearing after the mathematical operation equates to “ELSE DO THIS.”
4. Type:

   =IF(B10>100000,B10-$B$18*B10,IF(B10>80000,B10-$B$19*B10,IF(B10<80000,B10-$B$20*B10)))

   Compare results with what you see on page 36.
Lesson 6:

Making Decisions in Excel: Using Logical Functions

The following activities are designed to introduce you to the use of the Excel logical function IF for phrasing decisions in your calculations. The exercises are designed for you to perform as you read, so access to Excel and the worksheet *Example1* which we developed in Lessons 1-5 is highly desirable.

1. Modifying the commission rate scheme in our sales data example.

   Suppose we wish to change the way in which we allocate the commission rate to each of our sales regions. In our previous example, one rate was used for all regions. Let's assume now that the commission rate is set each six months as an incentive for higher sales in the following way. If a region attains total sales of more than $100,000 the sales commission rate will be 6%. If the region attains total sales of more than $80,000, but less than or equal to $100,000, the rate will be 5%. If a region's total sales are below $80,000, the rate will be set to 3.5%.

   We wish to modify our worksheet to account for these new rules. We begin by setting aside cells for the three sales commission rates as shown in the following figure. Note in that figure that we have deleted the formulas used before for computing adjusted sales, because those formulas must be adjusted now for the new commission scheme.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Sales - Region1</td>
<td>Sales - Region2</td>
<td>Sales - Region3</td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td>$22,876.00</td>
<td>$13,956.00</td>
<td>$6,545.00</td>
</tr>
<tr>
<td>3</td>
<td>Feb</td>
<td>$32,222.00</td>
<td>$3,412.00</td>
<td>$5,546.00</td>
</tr>
<tr>
<td>4</td>
<td>Mar</td>
<td>$14,321.00</td>
<td>$11,233.00</td>
<td>$7,796.00</td>
</tr>
<tr>
<td>5</td>
<td>Apr</td>
<td>$13,423.00</td>
<td>$23,421.00</td>
<td>$4,443.00</td>
</tr>
<tr>
<td>6</td>
<td>May</td>
<td>$15,532.00</td>
<td>$11,233.00</td>
<td>$8,999.00</td>
</tr>
<tr>
<td>7</td>
<td>Jun</td>
<td>$19,097.00</td>
<td>$22,111.00</td>
<td>$10,232.00</td>
</tr>
<tr>
<td>8</td>
<td>Total</td>
<td>$117,461.00</td>
<td>$85,366.00</td>
<td>$43,551.00</td>
</tr>
<tr>
<td>9</td>
<td>Average</td>
<td>$19,576.83</td>
<td>$14,227.67</td>
<td>$7,258.50</td>
</tr>
<tr>
<td>10</td>
<td>St. Dev.</td>
<td>$7,111.66</td>
<td>$7,505.37</td>
<td>$2,168.78</td>
</tr>
<tr>
<td>11</td>
<td>Adjusted Sales</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>High Commission Rate</td>
<td>6%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Normal Commission Rate</td>
<td>5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Low Commission Rate</td>
<td>3.50%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Constructing a formula for the conditional commission rate assignment.

Let's begin by constructing a formula for cell B15. We know we wish to subtract the commissions paid from the gross sales just as before. The difference is that the commission rate to be paid will in fact depend upon the gross sales. How can we phrase this unknown in our formula?

We'd like our formula to "make a decision" about which commission rate to use based on the value of the total sales. The Excel IF function provides exactly this kind of capability. The IF function is structured as follows.

IF(condition, action or value if condition true, action or value if condition false)

For example, the hypothetical expression (this has nothing to do with our example):

IF(A2 > 10, 25, 4*A2)

would assign the value 25 if the number in cell A2 is larger than 10 and assign the number 4 times the value in cell A2 if the value in A2 is not larger than 10.

With this in mind, we can begin the construction of our formula for cell B15. The first part of the formula is shown in the figure below. It computes the adjusted sales based on the rate in cell C18 whenever the total sales in cell B10 is larger than $100,000. We've left blank for the moment what happens otherwise.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>Sales - Region1</td>
<td>Sales - Region2</td>
<td>Sales - Region3</td>
<td>Totals</td>
</tr>
<tr>
<td>Jan</td>
<td>$22,876.00</td>
<td>$13,956.00</td>
<td>$6,545.00</td>
<td>$43,377.00</td>
</tr>
<tr>
<td>Feb</td>
<td>$32,222.00</td>
<td>$3,412.00</td>
<td>$5,546.00</td>
<td>$41,180.00</td>
</tr>
<tr>
<td>Mar</td>
<td>$14,321.00</td>
<td>$11,233.00</td>
<td>$7,786.00</td>
<td>$33,340.00</td>
</tr>
<tr>
<td>Apr</td>
<td>$13,423.00</td>
<td>$23,421.00</td>
<td>$4,443.00</td>
<td>$41,267.00</td>
</tr>
<tr>
<td>May</td>
<td>$15,632.00</td>
<td>$11,233.00</td>
<td>$8,998.00</td>
<td>$35,764.00</td>
</tr>
<tr>
<td>Jun</td>
<td>$19,087.00</td>
<td>$22,111.00</td>
<td>$10,232.00</td>
<td>$51,430.00</td>
</tr>
<tr>
<td>Total</td>
<td>$117,461.00</td>
<td>$85,366.00</td>
<td>$43,551.00</td>
<td>$246,378.00</td>
</tr>
<tr>
<td>Average</td>
<td>$19,576.93</td>
<td>$14,227.67</td>
<td>$7,259.50</td>
<td>$41,063.00</td>
</tr>
<tr>
<td>St. Dev.</td>
<td>$7,111.66</td>
<td>$7,505.37</td>
<td>$2,189.78</td>
<td>$6,334.31</td>
</tr>
<tr>
<td>Adjusted</td>
<td>$C$18*B10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High Comm. Rate</td>
<td>6%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal Comm. Rate</td>
<td>5%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Comm. Rate</td>
<td>3.50%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Now let's consider what happens whenever the sales figure in B10 is not larger than $100,000. It depends again. If the figure is larger than $80,000, we use the rate in cell C19, otherwise we use the rate in cell C20. This calls for a second IF function inside the first IF function. The following figure shows the first part of this second IF function being entered.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Month</td>
<td>Sales - Region1</td>
<td>Sales - Region2</td>
<td>Sales - Region3</td>
<td>Totals</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Jan</td>
<td>$22,876.00</td>
<td>$13,956.00</td>
<td>$6,545.00</td>
<td>$43,377.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Feb</td>
<td>$32,222.00</td>
<td>$3,412.00</td>
<td>$5,546.00</td>
<td>$41,180.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Mar</td>
<td>$14,321.00</td>
<td>$11,233.00</td>
<td>$7,766.00</td>
<td>$33,340.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Apr</td>
<td>$13,423.00</td>
<td>$23,421.00</td>
<td>$4,443.00</td>
<td>$41,287.00</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>May</td>
<td>$15,532.00</td>
<td>$11,233.00</td>
<td>$8,999.00</td>
<td>$35,764.00</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Jun</td>
<td>$19,087.00</td>
<td>$22,111.00</td>
<td>$10,232.00</td>
<td>$51,430.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Total</td>
<td>$117,451.00</td>
<td>$95,366.00</td>
<td>$43,551.00</td>
<td>$246,378.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Average</td>
<td>$19,576.83</td>
<td>$14,227.67</td>
<td>$7,256.50</td>
<td>$41,063.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>St. Dev.</td>
<td>$7,511.56</td>
<td>$7,505.37</td>
<td>$2,188.79</td>
<td>$6,334.31</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Adjusted</td>
<td>=SC19*E10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>High Commission Rate</td>
<td>5%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Normal Commission Rate</td>
<td>5%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Low Commission Rate</td>
<td>3.50%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Finally, if the sales amount is not larger than $80,000, we wish to use the rate in C20. This condition then finishes the formula off, as shown in the following figure.
3. The completed IF formula.

Study the nested IF function in the previous figure carefully so that you understand how it represents the procedure for assigning a commission rate that we described earlier. Once you are confident of that understanding, replicate the formula to cells C15 and D15. We do **not** want to replicate to E15 as before (why not?). The following figure shows the results your worksheet should now contain. Find and correct any errors before proceeding.
### Example 1

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Month</td>
<td>Sales - Region1</td>
<td>Sales - Region2</td>
<td>Sales - Region3</td>
<td>Totals</td>
</tr>
<tr>
<td>3</td>
<td>Jan</td>
<td>$22,876.00</td>
<td>$13,956.00</td>
<td>$6,545.00</td>
<td>$43,377.00</td>
</tr>
<tr>
<td>4</td>
<td>Feb</td>
<td>$32,222.00</td>
<td>$3,412.00</td>
<td>$5,546.00</td>
<td>$41,180.00</td>
</tr>
<tr>
<td>5</td>
<td>Mar</td>
<td>$14,321.00</td>
<td>$11,233.00</td>
<td>$7,786.00</td>
<td>$33,340.00</td>
</tr>
<tr>
<td>6</td>
<td>Apr</td>
<td>$13,423.00</td>
<td>$23,421.00</td>
<td>$4,443.00</td>
<td>$41,287.00</td>
</tr>
<tr>
<td>7</td>
<td>May</td>
<td>$16,532.00</td>
<td>$11,233.00</td>
<td>$8,999.00</td>
<td>$35,764.00</td>
</tr>
<tr>
<td>8</td>
<td>Jun</td>
<td>$19,087.00</td>
<td>$22,111.00</td>
<td>$10,232.00</td>
<td>$51,430.00</td>
</tr>
<tr>
<td>9</td>
<td>Total</td>
<td>$117,461.00</td>
<td>$85,366.00</td>
<td>$43,551.00</td>
<td>$246,378.00</td>
</tr>
<tr>
<td>10</td>
<td>Average</td>
<td>$19,576.00</td>
<td>$14,227.67</td>
<td>$7,259.50</td>
<td>$41,063.00</td>
</tr>
<tr>
<td>11</td>
<td>St. Dev.</td>
<td>$7,111.66</td>
<td>$7,505.37</td>
<td>$2,168.78</td>
<td>$6,334.31</td>
</tr>
<tr>
<td>12</td>
<td>Adjusted Sales</td>
<td>$110,413.34</td>
<td>$81,097.70</td>
<td>$42,026.72</td>
<td></td>
</tr>
</tbody>
</table>

### 4. Completing the worksheet calculations.

To complete the worksheet calculations, we need to supply a formula for cell E15 to compute the grand total of adjusted sales. We do this by adding the three regional total adjusted sales. We employ the SUM function as shown below.

$$=\text{SUM}(	ext{B15:D15})$$
Once the above formula is entered, you should have a worksheet containing the data shown below. Correct any errors you find before proceeding.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>Totals</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sales - Region1</td>
<td>Sales - Region2</td>
<td>Sales - Region3</td>
<td>Totals</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Month</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td>$ 22,876.00</td>
<td>$ 13,956.00</td>
<td>$ 6,546.00</td>
<td>$ 43,377.00</td>
</tr>
<tr>
<td>3</td>
<td>Feb</td>
<td>$ 32,222.00</td>
<td>$ 3,412.00</td>
<td>$ 5,546.00</td>
<td>$ 41,180.00</td>
</tr>
<tr>
<td>4</td>
<td>Mar</td>
<td>$ 14,331.00</td>
<td>$ 11,233.00</td>
<td>$ 7,766.00</td>
<td>$ 33,340.00</td>
</tr>
<tr>
<td>5</td>
<td>Apr</td>
<td>$ 13,423.00</td>
<td>$ 23,421.00</td>
<td>$ 4,443.00</td>
<td>$ 41,287.00</td>
</tr>
<tr>
<td>6</td>
<td>May</td>
<td>$ 15,532.00</td>
<td>$ 11,233.00</td>
<td>$ 8,999.00</td>
<td>$ 35,764.00</td>
</tr>
<tr>
<td>7</td>
<td>Jun</td>
<td>$ 19,087.00</td>
<td>$ 22,111.00</td>
<td>$ 10,232.00</td>
<td>$ 51,430.00</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Total</td>
<td>$ 117,461.00</td>
<td>$ 85,366.00</td>
<td>$ 43,561.00</td>
<td>$ 246,388.00</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Average</td>
<td>$ 19,576.63</td>
<td>$ 14,227.67</td>
<td>$ 7,258.50</td>
<td>$ 41,063.00</td>
</tr>
<tr>
<td>12</td>
<td>St. Dev.</td>
<td>$ 7,111.66</td>
<td>$ 7,505.37</td>
<td>$ 2,166.78</td>
<td>$ 6,334.31</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Adjusted</td>
<td>$ 110,413.34</td>
<td>$ 81,097.70</td>
<td>$ 42,026.72</td>
<td>$ 233,537.76</td>
</tr>
<tr>
<td>15</td>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>High Commission Rate</td>
<td>6%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Normal Commission Rate</td>
<td>5%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Low Commission Rate</td>
<td>3.50%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
LESSON 14: – Linking Spreadsheets
This exercise will show you how to link one spreadsheet’s data to another by way of using PASTE SPECIAL. You will make two separate workbooks and work with both on the screen to link the data.

1. Open MS Excel 2016 to a blank workbook, and maximize it on the screen.
2. Create a title within the spreadsheet by merging and centering four columns as shown below. To do this, highlight, with the white cross, cells A1 through D1. Then in the HOME tab of the ribbon, locate the button that is labeled “MERGE AND CENTER.” Click it, then type your title, “EMPLOYEE VACATION TIME FOR QUARTER 1,” in that area.
3. Title each of the other columns by leaving a blank row under your main title, then enter each title hitting the TAB key on the keyboard as we’ve done before, to advance to the next column.
4. Type the data in columns A, B, and C only.
5. In column D, write a formula that subtracts the used vacation time from the beginning vacation time, and use the AUTOFILL handle (since the formula is a relative reference) to fill in the rest of the data.
6. SAVE your work to a flash drive or onto your hard drive naming it something like “Quarter 1 Vacation” followed by your initials. Keep the file open and maximized.

Now that the first spreadsheet/workbook is finished, create a new, blank spreadsheet/workbook. We’re going to copy much of the information from the first spreadsheet into the next blank one we are about to create.

1. Create a new, blank workbook. Maximize it on the screen.
2. Correct the main title to say QUARTER 2 by double-clicking on the title to obtain a typing cursor.
3. SAVE this one right away as “Quarter 2 Vacation” with your initials either on the same flash drive or on the hard drive.
4. Right-click the Excel icon in the Dock at the bottom of the screen, and look for your QUARTER 1 file. Click it to make it the “active” or “current” spreadsheet.
5. Select your first 2 rows of data from Quarter 1 – these will be your titles for the columns and the overall spreadsheet. Click COPY.
6. Right-click the Excel icon in the Dock at the bottom of the screen, look for your QUARTER 2 file, and click IT to make IT the active spreadsheet.
7. Click your cursor in cell A1. From the HOME tab, click the arrow to the right of PASTE choose the option saying “keep source column widths.” Adjust columns as necessary.
8. Save your work.
9. Return to “Quarter 1 Vacation.”
10. Select the names in the first column, and highlight beyond Tom Thompson to include 5 blank rows.
11. Click COPY.
12. Make the Quarter 2 spreadsheet active.
13. Click your cursor in cell A5. Click the PASTE DROP-DOWN ARROW and click PASTE LINK.

### Employee Vacation Time for First Quarter

<table>
<thead>
<tr>
<th>Name</th>
<th>Beginning Vacation</th>
<th>Used Vacation</th>
<th>Balance Vacation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jones, John</td>
<td>65</td>
<td>8</td>
<td>57</td>
</tr>
<tr>
<td>Avery, Matilda</td>
<td>56</td>
<td>0</td>
<td>56</td>
</tr>
<tr>
<td>Bonsai, Alan</td>
<td>45</td>
<td>5</td>
<td>40</td>
</tr>
<tr>
<td>Johnson, Jewel</td>
<td>87</td>
<td>3</td>
<td>84</td>
</tr>
<tr>
<td>Thompson, Tom</td>
<td>76</td>
<td>5</td>
<td>71</td>
</tr>
</tbody>
</table>
Next, we will experiment to see if our PASTE SPECIAL, PASTE LINK choices “did” anything.

Let’s see if we can link WORD data...

1. Make your QUARTER 1 spreadsheet active.
2. Click in cell A8.
3. Type a name and hit TAB.
4. SAVE your spreadsheet.
5. Make your QUARTER 2 spreadsheet active.
6. Did the new name appear in this separate spreadsheet? If yes, then you successfully completed the PASTE, PASTE LINK steps! Congratulations!

Let’s try it again with NUMERIC data.

1. Make your QUARTER 1 spreadsheet active.
2. Highlight the numbers in the BALANCE VACATION column (column D) and go beyond the last entry, including about 5 more rows as we did before in the name column. Do not include the title.
3. Click COPY.
4. Click on your QUARTER 2 spreadsheet to make it active.
5. Click inside the BEGINNING VACATION column (B) and click PASTE, PASTE LINK.
6. Type in a formula in cell D3 to compute the balance of vacation time in Quarter 2, just like you did before.
7. Use the AUTOFILL handle to fill down the column to about cell D14.
8. Click inside cell C3 and type an imaginary used vacation time number. Do the same for the other names, including the new name you added.
9. Is the formula working in column D? It should be automatically filling in as you go.
10. SAVE your work.
11. Click on your QUARTER 1 spreadsheet. Add some figures for the name you had typed in.
12. Click on your QUARTER 2 spreadsheet. Do you see the figures reflected for the new name?

A little more about Paste LINK...

The paste special feature in your spreadsheet allows you to paste links, as we’ve seen, between separate workbooks but we can also link between sheets as well, using the same tool, within the same workbook if we choose. Also, PASTE SPECIAL, an option that also appears in the dialog box, provides additional ways for pasting, such as including just formulas or formats, or using the TRANSPOSE feature if we wish to take a horizontal row of data and make it vertical, or vice-versa.
Common Errors in Excel

#DIV/0!: If you enter a formula that divides by zero

#NAME?: If a formula contains a name that Excel does not recognize

The Example has SUM misspelled

####: The cell is too small to display a number

Return to Information Services Homepage
Return to John Carroll Homepage
LESSON 15: PivotTable Exercise

What is a PivotTable? In Microsoft Excel, a tool called a PivotTable, supposedly unique to Microsoft, is available to help display your data in an easy-to-understand, analytical way. PivotTable reports show comparisons and trends. They help reveal patterns or relationships between various pieces of data. Plain data can change from a very flat, ominous, and confusing format to one that is condensed, neatly summarized, and very sensible – all viewable and understandable very quickly to the reader. By learning to master this tool, you can showcase your data in “glance-able” style and with a more concise, understandable format.

Exercise 1: Open a salesperson spreadsheet with data and work with it using PivotTable tools.

1. Open DESKTOP from the Windows 8.1 start screen.
2. Open FILE EXPLORER, then LAB FILES.
3. Look for PivotTable Exercise.xml and open it.
4. Look at the data you see – notice column titles, which will become FIELDS later on in what is called a PivotTable Field List, and notice there are NO blank rows. Also notice the different types of data – currency – text – date – numeric. Dates are technically not numeric entries and are a format of their own. Notice also, that there is only one sheet of data labeled “Sheet 1.” This spreadsheet/worksheet has only 20 rows of data. Imagine a much larger spreadsheet of say, 500 names or more. The PivotTable becomes even more invaluable in this case.

Exercise 2: Open the PivotTable “toolkit.”

1. Click on a cell inside the data, for example, cell B4.
2. Click the INSERT tab on the ribbon, and click PIVOTTABLE.
3. Notice a dialog box appears like this one. Notice SELECT A TABLE OR RANGE is chosen, and the entire spreadsheet is selected – this is what we want at this point. NEW WORKSHEET is also selected, and this is fine, too. Click OK and continue.

Note: Visit www.microsoft.com for several online lessons on PivotTables. This exercise was largely based on one of the practice sessions in a Microsoft Excel 2007 PivotTable tutorial.

4. A new sheet appears. Notice a new tab called PivotTable Analyze and another called Design appears. These tools will only appear on the Ribbon IF you are clicked inside the PivotTable Report tool.
5. Notice the **PivotTable Field List** in the circle on the right. It has all 5 column titles that appear in Sheet 1. The titles have now become **Fields**. You will soon be checking these boxes to build a **PivotTable Report** in the box you see on the far left (where it says **PivotTable 2**).

---

**Exercise 3: How much have the salespeople sold?**

1. Let’s create a report showing how much the salespeople sold. In the **Pivot Table Builder’s Field List**, click the box next to **Salesperson**. Note that the PivotTable 3 Report box now looks like this.

2. Click the box next to **Order Amount** in the **PivotTable Field List**. Did you see another column appear in the report? Notice the currency formatting is no longer showing. You can reformat if you wish.

3. Change the heading name of this new column by clicking on its title (it probably says “**Sum of Order Amount**”) and click the **ANALYZE** contextual tab.

4. Click the **ACTIVE FIELD** group on this **ANALYZE** tab on the ribbon, and look for the current heading name (“**Sum of Order Amount**”). Click on it and rename it – something like **Total Sold** would be **OK**. Make sure the name you chose is **NOT** the same name as what appears in the **PivotTable Field Name sidebar**. This is an important rule when using PivotTables. Lastly, hit **ENTER** on the keyboard.
Exercise 4: Sorting the Report

1. How do the salespeople rank? Sort them by most sold to least sold.
2. Right-click on one of the amounts in the newly-named “Total Sold” field (or other name if you assigned it another name).
3. In the menu that appears, look for and point to SORT, then click LARGEST TO SMALLEST.
4. Peterman should come up on top with Perkins last.

Exercise 5: More advanced work – add another field to the PivotTable Report

1. Now let’s add the field, ORDER DATE, to the PivotTable Report. Drag the ORDER DATE field in the Report Builder down to the ROWS box and release. What happened?
2. Notice that the dates appear as subsets of each salesperson, on the left side of the report. The salespeople now have a − (minus) sign next to their name.
3. Click the − sign, and notice that the data “collapses” and is temporarily hidden from view. Also, the − sign changes back to a + (plus) sign.
4. Click the + sign once more, it “expands” and shows you the dates each salesperson made sales. Notice the + sign is now a − sign once again.

Exercise 6: More advanced work 2 -- Grouping your data together

1. If a lot of data contains either dates or times, you can group it, for instance, into days, months, quarters, or years. Click on a date, for example, the date that appears in cell A6.
2. On the ANALYZE tab, in the GROUP area, click GROUP FIELD. A dialog box appears that looks like this: Notice Months is highlighted.
3. Click Quarters. Only Quarters should have a blue highlight or selection at this point. Then click OK. Look at your PivotTable Report. What do you notice? The report shows the dates, grouped by quarters.
4. Expand and then collapse the amount of data under any given name. (Remember to click the + and/or − sign next to the salesperson’s name.) This shows once more how you can control the amount of data visible in the PivotTable Report.
Exercise 7: More advanced work 3 – Putting a Report Filter into the PivotTable Report

1. In the PivotTable Field List, drag the field labeled Country to the Rows box.
2. The field is added to the left. Notice how it is a subset of the Order Date Field, which you turned into Quarters. This makes it difficult to compare the data, especially if there were many more lines of data to examine.
3. Select any country name in the Pivot Table Report Box. In the Pivot Table Builder field box, re-arrange the fields that are currently in the Rows box such that Country is first, Salespersons is second, and lastly is Order Date.
4. Once you have done this, COUNTRY is at the beginning of the report.
5. Notice the now-familiar — sign before the country name. Click it. You should now see all the countries (only two in this case) and the total sales to each one appearing above. Much easier to analyze and compare.
6. Notice that the salesperson and order date fields are subsets below the country field, almost like in outline form.
7. There is still a better way to display this information instead of in row format. Clear the checkbox next to COUNTRY in the PivotTable Field List box (left-click). This will allow you to start over.
8. Right-click the COUNTRY field this time, and choose, by left-clicking on the menu that appears, ADD TO REPORT FILTER.
9. Notice the bottom part of the PivotTable Field List dialog box has a record of the choices you have made so far, in the areas divided by Report Filter, Row Labels, and Values. Right now, the Column area is not filled in.
10. Often, a report filter is used to focus on a particular aspect or subset of the data such as geographic location, product line, or time span. Here, we are focusing on geographic location. Notice country is now at the top of the report.
11. Click the drop-down menu arrow next to Country in the report, and notice you can select either China or the USA, or ALL, which is the default. Experiment by clicking all the choices. You will notice that the drop-down arrow changes visually into a filter tool as you click. This is normal.

Exercise 8: More advanced work 4 – Pivot the Report

1. Right-click order date in the rows box inside the Pivot Table Builder Fields box.
2. In the menu that appears, point to MOVE, and click on MOVE TO COLUMN LABELS.
3. Notice the grand totals at the bottom of each quarter’s column. Still another way to present data in an organized, quick-to-read format.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Country</td>
<td>USA</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Amount Sum</td>
<td>Column Labels</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Row Labels</td>
<td>Qtr1</td>
<td>Qtr2</td>
<td>Qtr3</td>
<td>Grand Total</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Peterman</td>
<td>$94,837.00</td>
<td>$87,321.99</td>
<td>$182,158.99</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Tompson</td>
<td>$4,623.99</td>
<td>$114,086.98</td>
<td>$39,876.88</td>
<td>$158,587.85</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Perkins</td>
<td>$81,041.85</td>
<td>$3,598.00</td>
<td>$84,639.85</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Hodgeman</td>
<td>$18,653.44</td>
<td></td>
<td></td>
<td>$18,653.44</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Grand Total</td>
<td>$118,114.43</td>
<td>$282,450.82</td>
<td>$43,474.38</td>
<td>$444,040.13</td>
<td></td>
</tr>
</tbody>
</table>

Exercise 9: More advanced work 5 – Finishing touches – change the Amount Sold number format to currency. (You may have already done this...)

Excel 2016 for Mac

Quick Start Guide

This new version of Excel is thoughtfully designed for your Mac. Use this guide to learn the basics.

- Get quick access to tools and commands
  See what Excel 2016 for Mac can do by clicking the ribbon tabs and exploring new and familiar tools.

- Quick Access Toolbar
  Keep popular commands right at your fingertips.

- Discover contextual commands
  Select charts, sparklines, and other elements in your workbooks to reveal additional tabs.

- Search your workbooks
  Start typing in the Search box to instantly find what you're looking for.

- Insert and edit functions
  Use the formula bar to view or edit the selected cell to insert functions into your formulas.

- Switch or create sheets
  Click the sheet tabs to navigate within your workbook and add additional sheets when needed.

- Show or hide the ribbon
  Need more room on your screen? Click the arrow to turn the ribbon on or off.

- Change your view
  Click the status bar buttons to switch between view options, or use the zoom slider to magnify the page display to your liking.
Create something

Begin with a Blank Workbook to get right to work. Or save yourself a bunch of time by selecting and then customizing a template that resembles what you need. To return to these options at any time, click File > New from Template.

Find recent files

Whether you only work with files stored on your Mac’s hard drive or you roam across various cloud services, clicking File > Open Recent takes you to your recently used workbooks and any files that you may have pinned to your list.

Stay connected

Need to work on the go and across different devices? Sign in to easily access your recently used files anywhere, on any device, through seamless integration between Office 2016 for Mac, OneDrive, OneDrive for Business, and SharePoint.

Set your preferences

Something not working quite as expected? It’s easy to change and customize options at any time. On the Excel menu, click Preferences, and then set up Excel the way you want.
Discover contextual tools

You can display additional ribbon commands by selecting specific items in your workbook. For example, select a chart to reveal the Chart Design and Format ribbon tabs, or select a sparkline to reveal the Design tab.

Enable optional add-ins

Get all of the statistical functions you need for conducting in-depth analyses of your data with the included Analysis ToolPak and Solver add-ins. On the menu bar, click Tools > Add-Ins, and then select the add-ins you want to enable.

Insert functions, build formulas

On the Formulas tab, click Insert Function to display the Formula Builder pane. Here, you can search for and insert functions, look up the correct syntax, and even get in-depth Help about your selected functions.
Share your work with others

Click the Share this workbook button in the top right corner to invite others to edit your current workbook, to copy a link to the file’s cloud location, or to send a copy as a file attachment from your preferred email service.

Get help with Excel

On the menu bar, click Help to search for the Excel features and commands that you need help with, or click Excel Help to browse through popular content. To let us know if the information we’ve provided has been useful to you, use the feedback form at the bottom of each of our Help articles.

Get other Quick Start Guides

Excel is just one of the newly designed apps in the new Office 2016 for Mac. Visit http://aka.ms/office-mac-guides to download our free Quick Start Guides for the new Mac versions of Word, PowerPoint, Outlook, and OneNote.

If you have any feedback about our guides, please submit your comments at the bottom of the download page. Thank you!

Send us your feedback

Love Excel for Mac? Got an idea for improvement? Click the smiley face icon in the upper right corner of the app window to send your feedback directly to the Excel development team.
**MS Excel 2016 Tips**

2. Visit the Excel, Preferences menu option for tweaking settings within Excel 2016 for the Mac.
3. If you see # # # # in a cell, widen the cell, and the contents should then be visible.
4. When you want to enter a number as a text entry, prefix it with a single apostrophe (’). Make sure this entry will not be used in a calculation. The number will remain on the left side of the cell, and an exclamation point will appear – you can click this error alert to reveal some choices including “ignore,” which is fine.
5. To have the time displayed in an Excel cell, press CTRL + SHIFT + :
6. To see the date displayed in an Excel cell, press CTRL + ;
7. *Hide* a column by right-clicking its column letter, and then select HIDE.
8. *Unhide* a column by selecting both columns on either side of the hidden one, right-clicking, and choosing UNHIDE.
9. You must have at least two sheets to do this: *Hide* a sheet by making it the current sheet, right-click the sheet tab, and look for and click on HIDE in the menu that appears. Right-click a sheet tab and look for UNHIDE to restore the sheet.
10. Enter a fraction by typing the fraction (with a leading 0 if it is between 1 and -1). For example, you can enter 1 3/4 but you need to type 0 3/4 and -0  3/4  for the smaller figures.
11. Go to any cell by pressing fn + F5 then type in the cell of reference, and click OK.
12. **Name a range** of cells by selecting them, they type a name in the Name box at the far left of the formula bar, and press enter on the keyboard.
13. When you have named a range, you can select it by selecting its name from the Name box.
14. Print any chart on its own page – select the chart in question and choose FILE, PRINT.
15. Press fn + SHIFT + F11 or fn + F11 to temporarily remove Excel from view, so you can look at the desktop. Repeat to return Excel to view.
16. Freeze a worksheet’s titles by placing your cell pointer below and to the left of the titles, and choosing VIEW, FREEZE PANES. By the same token, you can UNFREEZE panes as well – same way but under VIEW, you will see UNFREEZE if panes have been frozen.
17. If you think you may want to UNDO something, do not save your workbook as this may clear the Undo list and disable this option.
18. *Hide* the zeroes in a worksheet by choosing the menu, EXCEL, PREFERENCES, VIEW, and disable the Zero values box and click OK.
19. Apply a double underline to the data in a cell by clicking the dropdown arrow next to the Underline (U) button in the Home tab of the ribbon, and selecting the double underline option.
20. To make all columns a uniform width, click the SELECT ALL button in the top left corner of the gridline area, then widen only one column. All columns will now take on the width you chose. Deselect.
Answers to some common MS Excel 2016 questions...

1. How can you disable automatic typing in MS Excel 2016?
   a. This is called “autocomplete.” To turn it off, do the following while in Excel 2016:
      1. Click the EXCEL menu at the top of the screen.
      2. Click PREFERENCES.
      3. Click AUTO COMPLETE.
      4. Look for a checkbox with the words, “Use AutoComplete,” and uncheck it by clicking in the box.
   b. From this point on, you should notice that Excel WILL NOT provide or present you with pre-typed material.

2. How can I insert a chart, already created in Excel, into Word?
   a. First, open MS Excel 2016 and open the Excel Workbook with a chart already created in it. (such as Callahoose Grades)
   b. Click on the chart and COPY it.
   c. Minimize Excel or close it.
   d. Open MS Word.
   e. On the home tab of the ribbon, look for PASTE and click the triangle on the PASTE button for more options, as shown below.

   ![ Paste Options in Word ]

   f. Choose Keep Source Formatting & Link Data – This will connect both the Excel Spreadsheet’s data and chart, with the pasted chart in the MS Word document. (Consider the difference between link and embed, and pasting a link vs plain paste.)
      1. If you make changes in Excel that are reflected in the chart, the same chart in Word, also, should receive those changes in “real time” if you choose PASTE LINK.
      2. Link: Creates a dynamic copy of an item that can still be worked on in the program from which it was copied (from which it originated) and changes made to the object in the source file will automatically be reflected in the linked copy. Updates to the linked object occur when changes are initiated in the SOURCE document, from which the linked object was copied. “The main differences between linked objects and embedded objects are where the data is stored and how you update the data after you place it in the destination file.” — from Microsoft Help in Microsoft Word 2013.
      3. Embed: Copying an item and then embedding it into another document (such as a PowerPoint slideshow) allows for the copied item to be viewed in its entirety, independent of the source program. However, an embedded object will not retain changes made to its counterpart in the source document.
      4. Paste: A plain copy and paste results in the pasted object being static, non-dynamic, and incomplete if you copy and paste certain things such as PowerPoint slideshows.
   g. Alternatively, you can create a new chart while in MS Word – just click the INSERT tab on the ribbon, and look for CHART.